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This manual was written for use with the Westhold Race Manager for Windows software version 1.39.0.63. This
manual and the Westhold Race Manger software described in it are copyrighted, with all rights reserved. This manual
and the Westhold Race Manager software may not be copied, except as otherwise provided in your software license
or as expressly permitted in writing by Westhold Corporation (WESTHOLD).

Copyright © 2002-2010 by WESTHOLD. All rights reserved.

Microsoft and Windows are either registered trademarks or trademarks of Microsoft Incorporated in the United States
and/or other countries.

Use of the Westhold Race Manager software and other software and fonts accompanying your license (the
"Software") and its documentation are governed by the terms set forth in your license. Such use is at your sole risk.
The Software and its documentation (including this manual), and WESTHOLD software maintenance and extended
maintenance, if applicable, are provided ""AS IS'" and without warranty of any kind and WESTHOLD AND ITS
LICENSORS (HEREINAFTER COLLECTIVELY REFERRED TO AS "WESTHOLD") EXPRESSLY DISCLAIM
ALL WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE AND AGAINST
INFRINGEMENT. WESTHOLD DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE
SOFTWARE WILL MEET YOUR REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE WILL
BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED.
FURTHERMORE, WESTHOLD DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING
THE USE OR THE RESULTS OF THE USE OF THE SOFTWARE OR ITS DOCUMENTATION IN TERMS OF
THEIR CORRECTNESS, ACCURACY, RELIABILITY, OR OTHERWISE. NO ORAL OR WRITTEN
INFORMATION OR ADVICE GIVEN BY WESTHOLD OR A WESTHOLD AUTHORIZED
REPRESENTATIVE SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS
WARRANTY. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO
THE ABOVE EXCLUSION MAY NOT APPLY. UNDER NO CIRCUMSTANCES INCLUDING NEGLIGENCE,
SHALL WESTHOLD, ITS LICENSORS OR THEIR DIRECTORS, OFFICERS, EMPLOYEES OR AGENTS BE
LTABLE FOR ANY INCIDENTAL, SPECIAL OR CONSEQUENTIAL DAMAGES (INCLUDING DAMAGES
FOR LOSS OF BUSINESS, LOSS OF PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS
INFORMATION AND THE LIKE) ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE OR
ITS DOCUMENTATION, EVEN IF WESTHOLD OR A WESTHOLD AUTHORIZED REPRESENTATIVE HAS
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SOME JURISDICTIONS DO NOT ALLOW
THE LIMITATION OR EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES
SO THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY.

In no event shall WESTHOLD total liability to you for all damages, losses, and causes of action (whether in contract,
tort, including negligence, or otherwise) exceed the amount paid for the Software and its documentation.

Page 2



Table of Contents

Introduction

1.1 General Information
1.2 Requirements

1.3 Installation

1.4 Quick Start

Overall Description

2.1

Setup Tab
2.1.1 System Status/Control
2.1.2 Set Min Lap Time
2.1.3 Set Min Power
2.1.4 Set Backup Transponder Interval
2.1.5 Caution Handling

2.1.5.1 Finish Lap on Caution (Only for Scored Caution)

2.1.6 Auto Delete Partial Laps for Caution
2.1.7 Use Race Results for Lineup

2.1.8 Count First Crossing at Start

2.1.9 Count First Crossing on Return to Green
2.1.10 Score Red Flag Laps

2.1.11 Auto Delete Partial Laps for Red Flag
2.1.12 Auto Finish

2.1.13 Demo Mode On

2.1.14 Scoreboard Control

2.1.14.1 Set Comm Port

2.1.14.2  Total Positions

2.1.14.3  Scoreboard Type

2.1.14.4  Enable Scoreboard Output

2.1.15 Network Broadcast Control

2.1.15.1 Set Parameters
2.1.15.2 Enable Server

2.1.16 RMonitor

2.1.16.1 Set TCP/IP Port
2.1.16.2 Enable Network

2.1.17 Set Comm Port
2.1.18 Enable Serial
2.1.19 LapCeiver

2.1.19.1 Set Comm Port
2.1.19.2  Enable LapCeiver

2.1.20 Sound On

2.1.21 Organization Name
2.1.22 Default Track Length
2.1.23 Web Data

2.1.23.1 Set Data Path
2.1.23.2 Enable Live Web Data

2.2

Assign Tab
2.2.1 Assignment Template List
2.2.2 Add New
2.2.3 Delete
2.2.4 On Track Assign
2.2.5 Number of Laps

Page 3



23

2.2.6 Track Length
2.2.7 Print Line-Up
Timing Tab
2.3.1 Lap Display Box
2.3.2 Down Checkbox
2.3.3 RMon - Practice
2.3.4 Qualify/Place View Button
2.3.5 Scoreboard Button
2.3.6 Elapsed Total
2.3.7 Elapsed Green
2.3.8 Refresh Network
2.3.9 Scroll Lock
2.3.10 Place/Qualify Window

2.3.10.1 Notes
2.3.10.2  Assign
2.3.10.3 Double Click

2.3.11 Crossing Window

2.3.12 Unassigned Transponder
2.3.13 Pre-Start Button

2.3.14 Start Button

2.3.15 Caution Button (For non-scoring cautions)

2.3.16 Caution-Score Button
2.3.17 Red Flag Button
2.3.18 Lineup Screen

2.3.19 Finish Button

2.3.20 Stop Button

2.3.21 Crossing Window Pop-Up Menu (Used to modify crossing status)

2.3.21.1 Changing Crossing Type
2.3.21.2  Insert Manual Crossing
2.3.21.3  Delete Crossing

2.3.21.4  Insert Lap

2.3.21.5 Delete Lap

2.3.22 Results Tab
2.3.23 Print Buttons

2.3.23.1 Print Dialog
2.3.23.2  Print Image
2.3.23.3  Lap Chart Format

2.3.24.1

2.3.24 Menu Items

2.3.24.2 File->Close Menu Item

2.3.24.3
2.3.244

2.3.24.5 File->Exit Menu Item
2.3.24.6 File->Recover

2.3.24.7

2.3.24.8  Export Menu Item
2.3.249  Help Menu Item

Tutorials

3.1

Split Score Guide

File->Open Results Menu Item

File->Save Results Menu Item
File->Save Results As Menu Item

Options->Font Menu Item

19
20
20
20
21
21
21
21
22
22
22
22
22
22
23
24
24
26
26
27
27
29
29
29
30
31
32
32
35
37
38
39
40
41
42
42
42
43
43
43
43
43
43
43
44
44
45

46
46

Page 4



User Manual

1. Introduction

1.1 General Information

The Westhold Race Manager Software is used to control the Westhold RMS (Race Management System)
electronic race timing system. It has a simple and clean interface to facilitate the operation by the user.

1.2 Requirements

In order to install and use Westhold Race Manager, you must have the following:

IBM PC or compatible with 256M Bytes of free memory or more and at least 50M Bytes of free
hard drive space on your computer.

Microsoft Windows 95/98/ME/XP, Windows NT 4.0 or above, Windows 2000, Windows XP Pro,
Windows XP Home, Windows Vista, Windows 7. It is recommended that you have the latest
service pack for each operating system.

1.3 Installation

Place the CD in the computer. The installation program will automatically start on most computers. Some
computers will not do this. If this is the case click on the Windows <START> button and then click on run.
Type in <CD DRIVE LETTER>:\Setup.exe

Example:
D:\Setup.exe
This will start the installation program. Follow the instructions for installation. A Windows Desktop icon

will be created along with a program folder under the <START>\<Programs> location.

1.4 Quick Start

Before starting the software, verify the hardware has been configured properly. Be sure all the cables are
connected and secure. Make sure the PC is connected to the RMS IDU or the RMS IDEC box via a RS232
serial cable or TCP/IP network cable.

Power on the IDU or IDEC. A green power indicator on the front of the unit will light up.

Start the Race Manager program by double-clicking on the Desktop icon or selecting the program from the
<START>/<PROGRAMS>/<Perrano> location.

When the software is started for the first time some warning messages may appear regarding the setup of
com ports and the RMS. Fig. 1.4-1. This is normal. Click on the ‘OK’ buttons for the warning messages.
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x

& Canmot Open Serial Pork

=

& Can't Find RMS - Check Power, Check and Seleck Port

Fig. 1.4-1

2. Overall Description

The program is segmented into several logical sections. These are indicated by tabs at the bottom of the
program window. The three sections are Setup, Assign and Timing. The tabs are set up from left to right
in an attempt to indicate the typical flow of operation by the user.

2.1 Setup Tab

The setup page includes a number of parameters used to set up the software to communicate with the RMS
and scoreboard.

2.1.1 System Status/Control

The System Status/Control box is located in the upper left corner. It allows you to select the type of system
you are using and indicates the current status of the system. The Status box will initialize with the words
‘Not Found’ and the background will be in red color. If the RMS components are found the box will display
the appropriate data and the background color will be green. Typically the first time the system is started the
software will not discover the components. Some setup must first occur. Follow the procedure below to
initialize the system.
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1. Select the Receiver (i.e. decoder) type — IDU or IDEC

File Options Export  Help File Options Export  Help

 Spstem Status/Contral  Spstem Statuz/Control

[~ TCRAP

Set Comm F'Drtl I 1]
" : . OR

Fig. 2.1.1-1

Set Canm F'ortl I 1]

2. If you are using an IDEC select whether you want to use TCP/IP or not. If you are not using IDEC skip to
step 3. Depending on whether the TCP/IP checkbox is checked you will see the button below change to
either Set Comm Port or Set TCP/IP.

3. Click on Set Comm Port in the System Status/Control box. A list box will appear with the operational
com ports. Or in TCP/IP mode click the Set TCP/IP button and a window will pop up allow the entry of the
IP address and port number. The port number for the IDEC is 10001. You will have to use your hub or
router to determine the IP address that is assigned to the IDEC unit. The default IDEC address is
192.168.1.49. The name of the device will start with a ‘C’ and the last 6 digits of the IDEC serial number
(eg. CA6D2ELD).

NOTE: If your router assigns addresses to your computer as 192.168.0.XXX you will not be able to connect
to the IDEC. You must either change the router such that it assigns address in the same domain
192.168.1. XXX or you must change the IDEC address.

NOTE: It is also possible to connect your PC directly to the IDEC with a cross-over network cable.
However, you will have to assign your PC an address in the same domain (e.g. 192.168.1.5) as the IDEC.
Normally this will have to be done by giving your PC a static IP address.

4. Click the ‘OK’ button. Race Manager will attempt to discover and communicate to the RMS components.
When it successfully locates the components the indicators will light green and display the appropriate data.
For IDU systems the windows will display the IDU serial number as well as the decoder serial numbers. In
IDEC mode the time and date stamp will appear and update. The other 2 boxes will show firmware version
numbers.

File ©ptions Export Help File Options Expork  Help

— System Statuz/Conitrol
Receiver Type: &% DU ¢ IDEC

DU SM:
Main Dec SN:

Daigy Dec SH:

‘ 1

Fig. 2.1.1-2

— Spstem Status/Control
Receiver Type:  |DU (¢ IDEC

Wersion2:

¥ TCRAP

132.168.1.43:10001

IDEC
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2.1.2 Set Min Lap Time

This is used to set the minimum acceptable lap time. It is used to prevent unwanted detections such as when
a car spins out over the antenna and crosses it multiple times or when a transponder is accidentally brought
near the antenna or some other point where it can be detected by the Decoder.

To set the minimum lap time click on the Set Min Lap Time button and enter the number of seconds in the
window that pops up (Fig 2.1.2-1). Click OK when finished or Cancel to abort the operation.

Note: The crossing on the crossing screen will be Gray in color.

Enter Minimum Lap Time x|

Ok

1IZI| Seconds

Cancel

Fig. 2.1.2-1

2.1.3 Set Min Power

This is used to set the minimum acceptable detection power level. It is used to prevent unwanted detections
from stray transponders on the edge of the Decoder detection range.

To set the minimum power click on the Set Min Power button and enter the number of dB in the window
that pops up. Click OK when finished or Cancel to abort the operation. A typical threshold number is
about 19-20 dB. Some experimentation may be necessary to pick an appropriate value.

Note: Can leave set at 0.

Enter Minimum Power (dB) |

2.1.4 Set Backup Transponder Interval

This is only used if you are using two transponders per racer. To use this feature a backup transponder
number must be assigned in the Assign page (Section 2.2). This setting is the interval in which both
transponders must be detected to be considered a single crossing.

Enter Backup Transponder Time Interval

I':| Seconds

Fig. 2.1.4-1

Cancel

For instance, say transponder number 1001 is the primary and 1002 is the backup used for one racer. Say
the interval is set to 1 second. If 1001 is detected first and 1002 is detected within 1 second of 1001, 1002
will be determined to be a backup transponder. This is also true if 1002 is detected first and 1001 is detected
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within 1 second. What will appear on the screen is the primary transponder number assigned. In this case
1001 will always appear whether or not 1002 was detected first.

2.1.5 Caution Handling

This group of controls is used to set parameters for how caution conditions will be handled.

2.1.5.1 Finish Lap on Caution (Only for Scored Caution)

This feature is used to handle split scoring situations. If the box is checked, the competitors will be scored
only once when they cross the start/finish after the Caution-Score button on the timing screen is pressed. If
not checked, all scored caution laps will be counted when computing the position of the competitors.

This is also used in situations when competitors race to the yellow.

Note: Read tutorial section for information on split scoring.

2.1.6 Auto Delete Partial Laps for Caution

If this box is checked partial laps will be marked as caution when press the non scoring Caution button on
the timing screen. For instance, if there are 10 competitors on the track and two vehicles cross the
start/finish line before the caution flag is thrown, the crossings by the first two vehicles will be automatically
marked as caution.

2.1.7 Use Race Results for Lineup

If this box is checked the caution lineup will arrange competitors based on their last race position. If the
box is unchecked, the lineup is created based on the order the cars crossed the start/finish. Typically this
box is left unchecked.

Note: Check box if wanting to put lap cars to rear of the field.

2.1.8 Count First Crossing at Start

If this box is checked the first crossing will be counted as a lap. This is often used when the start is different
than the finish/scoring line such as in motocross racing. If the box is not checked the first crossing will not
be counted, but the second crossing will be counted as the completion of the first lap.

Page 9



Eile Options

Export

Help

Lap: I 2

oh - Practice

First crossing is
counted

Place: Mo, | arne T« ID Laps

1 0z B Two 1002 2

2 03 C Three 1003 2

3 04 O Faur 1004 2

4 05 E Five: 1005 2

5 01 A Cne 1001 z

| 0|

PHE-
“\ START “\ START ‘\ CAUTION

Qualify View | Scareh i I &Tie— Ez[[ﬁzi
Index Ma. Manne: | T IC Lap | Laptime Speed
1-L 04 D Four 1004 1 === ===
2 os E Five 1005 1 e e
3 o1 A One 1001 1 e e
4 0z B Two 1002 1 e e
5 03 C Three 1003 1 e e
b-L 02 B Two 1002 2 05.111 0.000
7 03 C Three 1003 2 05,079 0.000
g 04 [ Four 1004 z 05,293 0.000
9 s E Five 1005 2 05,323 0.000
10 o1 & One 1001 2 05,344 0.000
21 |
All Single | Fesullz I

CAUTION -
SCORE

‘\ RED FLAG

o

FIMISH

STOP

LINELF |

=" Race Manager

Setup | Assign Timing |

Fig 2.1.7-1 — Count First Crossing at Start is checked

Ele Options Export  Help . .
First crossing p———
- [~ Down - i ="y is not counted Refresh Sc
Lap: I 1 M I_ S not Nework | Lo
Place Mo, | Hame | Tx ID | Laps | Lag | Adjus \ -
Index Mo, Mame | Tx ID Lap | Lapkirn.
1 a3 C Three 1003 1 0o.000 0
1-L o4 D Four 1004 === ===
z 04 D Four 1004 1 -00.051 |0 .
2 a5 E Five 1005 o e
3 1) E Five 1005 1 -00.103 0 -
3 o1 A One 1001 - -
4 o1 A Cne 1001 1 -00.190 0
4 oz B Twa 100z . e
5 0z E Twio 100z 1 -00.272 0
5 o3 C Thres 1003 . e
B-L o3 C Three 1003 1 05.08
7 04 O Faur 1004 1 05,34z
g 0s E Firve 1005 1 05,231
9 o1 A One 1001 1 05, 33¢
10 0z B Two 100z 1 05, 40¢
| s
4 | All Single Hesultsl
FRE- CAUTION - # ; Lirlgue |
d\ START A START A CaAUTION SCORE A RED FLAG &«\ FINISH STOP
Setup | Assign _Timing |

Fig 2.1.7-2 — Count First Crossing at Start is unchecked
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2.1.9 Count First Crossing on Return to Green

2.1.10

2.1.11

2.1.12

2.1.13

2114

If this box is checked the very first crossing after returning from either a caution or restart to green condition
will be counted. In this case the start (green flag) button is pressed after all the vehicles have gone by the
start/finish and the flag person has thrown the green flag.

If this box is not checked the very first crossing is not scored after returning to green condition. In this case
the start (green flag) button is pressed as the flag person throws the green flag and before the vehicles have
crossed the start/finish.

Score Red Flag Laps

If this box is checked when clicking red flag button the laps will count instead of not being scored in a
typical red flag circumstance.

Auto Delete Partial Laps for Red Flag

If this box is checked when partial laps will be marked as red when pressing the Red Flag button on the
timing screen. For instance, if there are 10 competitors on the track and two vehicles cross the start/finish
line before the red flag is thrown, the crossings by the first two vehicles will be automatically marked as red.

Auto Finish

If this box is checked the software will automatically activate the Finish Flag button when the specified
number of laps is reached. The number of laps for a race is specified per assignment on the Assign Tab.
See section 2.2.5.

Demo Mode On

When this checkbox is checked the software is placed in a demonstration mode. This is useful for learning
about the system without having all the hardware equipment connected. In this mode it is also possible to
output scoreboard data and test the scoreboard feed.

In Demo mode the software will output transponder numbers from 1001 to 1010 in random order when the
race view is active. The race information will continue until the Finish button is pressed. If the qualify view
is active the numbers 1001-1005 will be shown with each of the transponders numbers making 4 crossings.
Note that the lap times are not realistic numbers. They are simply used to demonstrate some of the software
features and exercise the scoreboard output.

Note: System Status/Control com ports will turn yellow with DEMO MODE inside of them. It is
recommended that the Min Lap Time is set to 0 sec and Min Power is set to 0 dB in demo mode.

Scoreboard Control

This section contains the controls to set up the scoreboard. In order to use the scoreboard to display data you
must first properly connect the computer to the scoreboard controller. The PC must have a second available
RS232 serial port or a USB to serial adpater in order to use the scoreboard. Be sure to have the PC and
scoreboard controller connected before enabling the scoreboard output.
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2.1.14.1 Set Comm Port

This is used to select the port that will output data to the scoreboard.
Click on the Set Comm Port button. A window with a list of ports will appear.

Select the appropriate port and click OK.

Select Pork x|

Com 1
Com 2

Lo 4 Cancel |

Fig. 2.1.11.1-1

2.1.14.2 Total Positions

This control is used to set the number of positions on the scoreboard. Be sure to select the proper number
for the scoreboard being used. This limits the amount of data sent from the software to the scoreboard. If the
software is set for more positions than the scoreboard supports both the software and scoreboard have to
process extra data. Some scoreboards may also exhibit unpredictable behavior. To set the number of
positions use the up and down arrow buttons next to the control to increment or decrement the number.

2.1.14.3 Scoreboard Type

Use the scoreboard type list box to select the type of scoreboard that will be used.

Daktronics: This is for Daktronics scoreboards operating with the All Sport 5000 series controller. In order
to use this option there are certain settings that must be made to the All Sport controller. First the console
must be placed in proper configuration by using the code corresponding to transponder usage and the proper
scoreboard. Second, place the console in race mode (not qualify) and press either ‘Display Time’ or
‘Display Laps’ button.

Generic: This is for scoreboards that are programmed to work with the generic scoreboard protocol provided
by Race Manager. Both All American scoreboards from Everbrite as well as TSI Timers scoreboards can be
configured for operation with Race Manager. Note that a separate hardware or software update may be
necessary from the scoreboard manufacturer. Please contact the appropriate manufacturer for additional
information.

Race America and Westhold selections will work with those respective scoreboards.

2.1.14.4 Enable Scoreboard Output

Before the Race Manager software will output data to the scoreboard, this checkbox must be checked.
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2.1.15 Network Broadcast Control

This section contains the controls to set up the software to act as an information broadcast server that can
broadcast information to an IP address on a network (wired or wireless). This feature is used in conjunction
with programs such as the Westhold RMViewer, a software application used by announcers and other
personnel monitoring the race from a networked computer.

The IP Address shown in the window is the address of the computer the Race Manager software resides on.

 Scoreboard Caontral
Tatal Positions

= |5 3

j Scoreboard

IDaktmnlcs T

[~ Enablz Scoreboard Oubput

 Metwork, Broadeast Contral

IF'Address:I 192168.1.1M
Part: I G000

[¥ Enable Server Set Parameters |

Fig. 2.1.12-1

2.1.15.1 Set Parameters

This is used to set the IP port that the information service will broadcast over. The default is 6000.

2.1.15.2 Enable Server

To enable the network information broadcast server this checkbox must be selected. If this is not enabled
the RMViewer software or other software using this data feed will be unable to connect to the service and
obtain race information.

2.1.16 RMonitor

This section contains the controls for outputting an RMonitor protocol stream. This is similar to the
Network Broadcast Control (Section 2.1.15). However, the output data stream is different and is used to
support software and hardware devices that use this protocol.

NOTE: Some scoreboards will use the RMonitor feed. In this case it is not necessary to set up the
Scoreboard Control section.

2.1.16.1 Set TCP/IP Port

This is used to set the IP port that the RMonitor information will be broadcast over.
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2.1.16.2 Enable Network

2.1.17

2.1.18

To enable the RMonitor information broadcast server this checkbox must be selected. If this is not enabled
devices expecting a data stream will be unable to connect to the service and obtain race information.

Set Comm Port

This is used to select the serial port to output the RMonitor data on.
Click on the Set Comm Port button. A window with a list of ports will appear.

Select the appropriate port and click OK.

Select Pork x|

Com 1
Com 2

Lom 4 Cancel |

Fig. 2.1.17-1

Enable Serial

To enable the serial port to transmit RMonitor data this checkbox must be selected. If this is not enabled
devices expecting a data stream will be unable to obtain the data feed.

2.1.19 LapCeiver

This section contains controls used to enable the output used for the LapCeiver hand-held.

Fig. 2.1.19-1 LapCeiver and LapCeiver Transponder
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2.1.19.1 Set Comm Port

This is used to select the serial port to output the LapCeiver data to the LapCeiver transmitter.
Click on the Set Comm Port button. A window with a list of ports will appear.

Select the appropriate port and click OK.

Select Pork x|

Com 1
Com 2

Lo 4 Cancel |

Fig. 2.1.19-1

2.1.19.2 Enable LapCeiver

To enable the serial port to transmit LapCeiver data this checkbox must be selected. If this is not enabled no
data will be transmitted by the LapCeiver transmitter.

2.1.20 Sound On

Check this box to enable the PC to output a beep each time a crossing is detected during a race. This is a
useful feature to help determine if a transponder was detected.

2.1.21 Organization Name

Enter your organization name (e.g. Westhold Raceway) that will be placed on printouts, the RMonitor data
output and exported data.

2.1.22 Default Track Length

Click on the Default Track Length button to bring up a window that allows the entry of the default track
length. This is used to set the default track length when creating a new transponder assignment template.

Track Length x|

0.000 Miles

Cancel

™ Use Metric Units

Fig 2.1.22-1
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Click on the Use Metric Units checkbox to change the type of units to use for the speed calculation.

NOTE: You must set this to a non-zero number in order to see the average lap speed displayed on the
timing screen.

2.1.23 Web Data

This section describes how it is possible to generate data for live internet feeds to the World Wide Web or
for a local in-the-pits data feed that racers or fans may view. Many Microsoft based PCs have a web server
built in. It is possible to configure a PC to feed race data information which can be broadcast over a wired
or wireless network to racers or fans. Data can then be viewed with a PC, PDA or other devices with that
can connect to the network and have a web browser.

The server PC can be the computer running Race Manager or it can be a different computer on the local
network. It can even be a computer hooked up to the internet.

When Race Manager is timing a race and the web data section is enabled, Race Manager will output a file
called ‘racedata.xml’ file every 1 second. This file contains information about the race including the race
order and lap time information. This file can be used with the additional data files Race Manager generates
as described below or can be parsed and used in a custom setting.

///,’E

_ PCs, PDAs or Cell Phones in
the Pit Area or other parts of
the facility

Race Manager
PC

Data Server — This can
be the same as the Race
Manager PC

Computers on Internet
Fig. 2.1.23-1

2.1.23.1 Set Data Path

Click on the folder icon to set the directory where you would like the race data file to be output. If Race
Manager determines the folder does not contain the default web pages and associated files needed to display
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in-the-pits information it will ask if it should create those files. The files include HTML, PHP and Java
Script files. You must have your web server configured properly to serve up this data.

It is not necessary to have these files if your IT person will not be using them. Instead your IT person can

use the ‘racedata.xml’ file and create custom web pages and data feeds. For an example of usage visit the
‘LiveTiming’ section of the www.westholdtiming.com website.

—wieb Data

Set Data Path
I Wit estholdtrminghweansanebroot @

¥ Enable Live 'Web Data

Fig. 2.1.23.1-1

2.1.23.2 Enable Live Web Data

Check this box to enable the output of the ‘racedata.xml’ data file to the specified directory.

2.2 Assign Tab

The Assign page is used to create a mapping between transponder serial number identifications and vehicle
numbers and participant names.

Serial number

Fig 2.2-1 - Transponder
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== Race Manager

File ©Options Expart Help

Print Line-up |

LATE MODELS
MODIFIEDS
Columns are sort able. Click on a
column header to sort ascending or
descending.
dddNew |  Dekte |
On Track Assign - DEMO
Mumber of Laps: IT Track Length: lw
Index Trns ID | Racer Mo, | Last Mame | Firsk Marmne /| Nisc Backup Trns ID
1 1001 1 one xpert 1011
2 1002 2 Two I -
3 1003 3 Three Christing Mowvice
4 1004 4 Faur pavid
5 1005 5 Five Expert 1012
6 1006 6 Six Expert 1013
7 1007 7 Seven Novice
3 1008 8 Eight - 1014
E 1003 g Hine Novice
10 1010 10 Ten Novice

Setup  Assign ITimingI

Fig 2.2-2 — Assign Tab

Enter the transponder serial number (Trns ID) and the racer number (Race No.) the transponder is assigned to. This
is the minimum data needed to score a race. The Misc column can be any data desired. This can be useful for

classifying different types of racers.

It is possible to assign two transponders per racer. The second transponder would be entered in the Backup Trns ID
column. Backup transponders are rarely used, but in cases where the race data is critical such as for television
broadcast it can be useful. See section 2.1.4 for additional information on backup transponder usage.

2.2.1 Assignment Template List

A list of available assignment templates is show in the box at the top of the screen. Each template has a set
of mappings between transponder ID and car numbers. A template may be selected at any time, even during

arace.

NOTE: Be careful when selecting a template during a race as this will change what is displayed on the
Timing screen as well as on the scoreboard.

The assignment template can be viewed as a class or even a heat assignment. Usage will vary depending on
the user and how they choose to organize the assignment templates.
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2.2.2 Add New

This is used to create a new assignment template. Click on the Add New button and a window will pop up
asking for an assignment name. Type in a name and click OK when done. Click Cancel to abort

New Assignment x|

Mew Azzighment

I Cancel |

Fig 2.2.2-1

2.2.3 Delete

This button is used to delete an assignment template. To delete a template, click on the template to from the
list and click the Delete button. This will permanently delete the assignment template and all the assignment
information.

2.2.4 On Track Assign

The On Track Assign window is used to create the mapping between the transponder ID and the vehicle
number.

Select the assignment template from the list of assignment templates.

Now enter new data or modify existing data from the template. First enter the transponder serial number
which is four numbers. This is found on the outside of the transponder. Then enter the vehicle number and
other relevant information. It is not necessary to enter driver names, but it can be helpful when generating
reports later on.

To create a new entry simply hit the Enter key on the PC keyboard and a new line will appear.

To delete an entry, simply highlight the data to delete and hit the Delete key on the PC keyboard.

2.2.5 Number of Laps

The total number of laps may be entered in the edit box. When the total number of laps is reached during a
race, the race is automatically finished as if the “Finish” button on the timing page were pressed. This gives
every competitor one more valid crossing.

Note that if this feature is being used the number entered should always be verified prior to a timing session
since the number of laps for heat races are often different than that used for the feature race.

2.2.6 Track Length

The track length is the length of the track in miles or kilometers depending on the default mile/km setting
found on the Setup page. When a new assignment template is created, the default track length from the
Setup page is entered for the new template.
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Note: Make sure both track lengths match so that speeds will appear on Timing Screen.

2.2.7 Print Line-Up

This prints the assignment template currently open. Click on the Print Line-up to print a copy of what is
currently displayed on the On-Track assignment screen.

2.3 Timing Tab

This page is used during timing and scoring operations. The current running order or qualifying order is
displayed on the left-hand side window and the crossings are displayed on the right-hand side.

=* Race Manager - C:'Westhold',Products,RMS"Source, TimePro'RaceMgr_139049\Recovery.CSY ‘N =loix]
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Fig 2.3-1

2.3.1 Lap Display Box

This displays the current lap if the Down checkbox is unchecked. If the Down checkbox is checked the
display shows the number of laps left in the race. If the scoreboard is enabled, the lap count will also be
reflected in the scoreboard output.
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Note: A number other than 0 must be entered for the session on the Assign Tab screen if you want to count
downwards. Otherwise, the display will count upwards.

2.3.2 Down Checkbox

If this checkbox is checked and the number of laps entered on the Assign Tab screen is greater than O then
the lap display will indicate the number of laps left in the race. If this checkbox is unchecked the lap
indicator will indicate the current lap.

Once the countdown reaches 0, the counter will stop at 0 even if more laps are run.

2.3.3 RMon - Practice

This is used on conjunction with the RMonitor feed. If the checkbox is NOT checked, the transmitted
session name will include the word ‘Race’ in it. Otherwise it will not. This is useful for software or devices
which use this feed to indicate whether the session is a practice session or a race session.

2.3.4 Qualify/Place View Button

This button toggles the Place/Qualify window between a running order (or place) display and the qualify
display. In the place display the current running order is show with the leader at the top. The Qualify view
will display the current qualifying order sorted by fastest lap.

NOTE: This view may be changed during a race or qualifying session. However, the scoreboard
display will also change so caution must be used when selecting the view.

Each column’s contents are described by the header at the top of the column. The Tx ID column also
displays additional information besides the transponder ID number. If the battery of the transponder is low
(1 day or less battery life) the word “Batt” will appear next to the transponder ID.

2.3.5 Scoreboard Button

The scoreboard button opens up a scoreboard control dialog. The ‘G’ button informs the scoreboard to turn
on its green light. The “Y’ button turns on the yellow light and the ‘R’ button the red light. The ‘Clear’
button will send a reset command to the scoreboard which will either blank the scoreboard or put all zeroes
into the scoreboard positions. Note that not all scoreboards will respond to all the buttons.

Clear

Fefrezsh

el

Fig 2.3.5-1
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2.3.6 Elapsed Total

The elapsed total display shows the total time that has elapsed since the Start button was pressed. The time
is displayed in hours:minutes:seconds format. When the Finish button is pressed the time stops updating.
This feature is useful for noting if a race is going beyond its allotted time frame. The information is saved
along with the race information.

2.3.7 Elapsed Green

The elapsed green display shows the total time that has elapsed under Green flag conditions. The time is
displayed in hours:minutes:seconds format. When the Yellow, Red, or Finish button is pressed the time
stops updating. This feature is useful for noting the time it has taken to run the race under race conditions.

2.3.8 Refresh Network
Clicking this button causes Race Manager to send information via the Network broadcast and RMonitor data
feeds. This is useful for forcing an update when something has changed.

2.3.9 Scroll Lock

This causes the crossing screen from scrolling when the RMS detects new crossings. Click on the Scroll
Lock button to toggle this feature on and off.

This is helpful when wanting to go back and check on a lap or vehicle that might have lost a lap and would
like to find it.
2.3.10 Place/Qualify Window

The Place/Qualify Window on the left side of the screen is used to display the current running or qualifying order.

2.3.10.1 Notes

When the window is displaying the place view the right mouse button may be clicked and a pop-up window

will display and allow the software user to adjust laps up or down for a vehicle and make notes. To do this a
vehicle must first be highlighted. Use the mouse cursor to click on the desired line in the window and select
the vehicle. Then right mouse click and click on the Notes selection to bring up the lap adjustment window

as show in the figure below.
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ll == Race Manager - C:Westhold',Products',EMS" Source’, TimePro',RaceMagr_1390:

t File ©Options Export Help
Lap: I 1 I Down [ Rbon - Practice Oualify View | Scoreboard
Session Name
Place Mo, |Name |Trns... |La|:|s Lag |Adjust |
1 449 Christine Three 14449 1 0o, aoo 1]
z2 85 Bob Two 14185 |1 -00.122 ]
4 49 Fred Five 14649 |1 Aissign
5 &7 Adam Cne 14067 1 0.
Fig 2.3.10.1-1 Place/Qualify Window
x|
Car Ma: 51 |La|:us: 1
Cancel
AdjList [+4]: IIJ 3: 4'
=
Adjust laps up or
= down
Add notes

Fig. 2.3.10.1-2 Notes

Clicking the up and down arrows of the Adjust (+/-) entry will increase or decrease the number of laps for a

car.

Note: This adjustment is only a rough adjustment. It cannot be used to place a vehicle in exactly the

correct spot. Be very careful when using this feature.

When used it may cause a vehicle to appear in the incorrect spot. Upon the next crossing of the vehicle over
the start/finish the vehicle will get an actual crossing time and be sorted in the correct order. To more
accurately add a lap use the Insert Manual Crossing feature described in section 2.3.21.2.

The text box may be used to add notes that may be referenced later.

2.3.10.2 Assign

To make changes to the car number or assignments right mouse click on the line that will be changed.
Select the Assign selection and a dialog box will pop up to allow you to make changes or assignments.

£

Serial Mumber: |9033

Car Number: |3 Cancel |

First Marne: ID
Last Marme; IFour

Fig 2.3.10.2-1 Assign
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Make the changes and press the OK button. Pressing the Cancel button will cancel and changes made.

Note: Any changes made here will not be reflected on the assignment template.

2.3.10.3 Double Click

Double click on one of the racers in the Place/Qualify window will manually insert a crossing to the end of
the crossing list. This is useful if a racer should be credited for a lap, but went through the in-field and
missed the detection loop or went into the pits.

2.3.11 Crossing Window

The Crossing Window is used to display all crossings. There are three tab selections for this window-ALL,
Single and Results. By selecting ALL, every crossing by every vehicle will be displayed. By selecting
Single the crossings of a single vehicle selected on the Place Window will be displayed. To do this click
and select the desired line from the Place/Qualify Window. See section 2.3.22 for information on the

results tab
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Fig. 2.3.11-1 All Tab

There are several columns in the Crossings window. Most are self-evident. The last column, Hits/Power,
has very useful data. This data can help trouble-shoot your setup. It can help determine if a transponder is
mounted poorly or there is possible external interference to the system.

Each transponder transmits its serial number over and over again very rapidly on a periodic basis. The Hits
number indicates how many times the system “saw” the serial number being transmitted as it passes by the
start/finish line detection point. The faster the vehicle crosses the detection point, the lower the Hits number

will be.
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The Power number is a measure of the transponder’s signal strength. Strength numbers below mid 30s
indicate possible problems either with the transponder location or poor cable connections in the antenna loop
or coax cable.

Hints
1. As each vehicle crosses the start/finish verify that the power numbers are consistent and above high 30’s.

2. If a transponder has numbers on average lower than the rest by about 10 then that indicates the
transponder is not mounted in the same way as the other cars. If the Power number is low then the
transponder should be relocated to a better position.

3. If the Power number is in the good range (about 40 and above), but the Hits number is low compared to
other cars, this indicates poor mounting position. This means that the transponder is not being “seen” very
well. It could be that the transponder is in a recessed location surrounded by metal or facing the wrong
direction (Label side of transponder should fact the antenna loop)

4. If the Power number is good, but the Hits number is erratic at a given speed this indicates either poor
mounting or interference.

5. Low power number on all vehicles indicates poor connectivity in the wiring or poor mounting on all
vehicles.
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Fig 2.3.11-2 — Single Tab
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2.3.12 Unassigned Transponder

When transponders are not assigned to a competitor under the Assign tab the transponder number will show
up in RED under the crossing screen. At any point during the race the transponder may be assigned to a
competitor under the Assign tab or by right mouse clicking the transponder on the Place/Qualify window

Elapzed Total Elapzed Green Refresh Scroll
fetwork | Lock
h 00:27.55 —‘ (] 00:27.01 —‘

Index |ma. Mame Trns ID Lap |Laptime |Speed Hits/Powe_~]
1-Pre
2-Fre -
3-Pre -
S-Pre -
b-L 85 Bob Two 14185 -—— - -—= 220,/35.0
7 449 Christine Three 14449 el s S 206135.0
g 16 Ernie Four 14716 el s S Z17140.0
9 49 Fred Five 14649 el s S 230133.0
10 &7 Adam Cne 14067 el s S 2431365
11-L [449 Christine Thr... 14449 1 08.461 0.000 164,30.0
1z 85 Bob Two 141385 1 08.674  0.000 159/32.5
13 16 Ernie Four 14716 1 08,393  0.000 125/33.0
14 4 Fred Five 14649 1 08,915 0.000 236/34.5
15 7 Adarn One 14067 1 08,927 | 0.000 242136.5
16 ID=14462 | 14462 - |- --- 124)32.5
Unassigned
transponder
A | _'l;I
&l I Single I Hesultsl

RED FLAG
\ [

STOR [F7)

a:':\ FINISH [FE&]

LINEUF'l Pint
[ PL&EEl ALL |

Note: DO NOT set any extra transponders within 20 Feet from scoring loop (cable in ground of track, and
cable running from tower to track), or any computer equipment (Computer and decoder). These can be
picked up inadvertently.

2.3.13 Pre-Start Button

This button is used to pre-start a timing session. The crossings are recorded and shown on the crossing
window, but not scored. This is useful for verifying that each vehicle has a transponder and that it is
functional properly. Pre-start crossings are highlighted in blue. See fig 2.3.13-1 below.

Note: Highly recommended to use on pace laps before start of race.
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Fig 2.3.13-1 — Pre-Start crossings in blue

2.3.14 Start Button
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To begin a timing session, click on the Start button. It is not necessary to select an assignment template
from the Assign page. If no assignment template is selected or a blank one is selected the display will only
indicate the transponder ID numbers. Although it possible to change a template selection during a session, it
is NOT recommended, as this will change the output to the Timing page and the scoreboard.

2.3.15 Caution Button (For non-scoring ¢

autions)

If a caution occurs this button may be pressed and a caution condition will be enabled. This causes the
crossings on the Crossing Window to display the affected crossings in bronze if it is in the All view. All

crossings are highlighted and will not be
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Fig 2.3.15-1 Caution
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If the Auto Delete Partial Laps for Caution checkbox on the Setup page is checked a partial lap will be

deleted and not scored.
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Fig 2.3.15-2 Before Caution Button
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Fig 2.3.15-3 — Auto Delete Partial Lap
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2.3.16

2.3.17

2.3.18

When the Caution button is clicked a screen with the current lineup will appear showing the order the cars
crossed the start/finish line during the last complete lap. See section 2.3.18 for details.

After the caution period is over click on the Start button to go back to a green condition. If the item Count
First Crossing on Return to Green is checked on the Setup page described in section 2.1.8 the very first
crossing over the start/finish line will be scored. If this is the case, the computer operator should wait until
all the vehicles have passed the start/finish when the green is thrown before clicking on the Start button.

If the option Count First Crossing on Return to Green is not checked the operator should click on the
Start button just as the green is thrown, but before the vehicles cross the start/finish. The very first crossing
will not be counted. The subsequent crossing will then be counted as the first completed lap.

Caution-Score Button

The Caution-Score button is used when the caution crossings will be scored. All crossings in this case will
be scored unless the Finish Lap on Caution (Only for Scored Cautions) checkbox described in section
2.1.4.1. See the tutorial section 3.1 for a guide to split scoring

Red Flag Button

If a red flag condition occurs pressing this button will cause a red-flag to be enabled. All crossings affected
will be highlighted in red. See section 2.3.18 for details on the lineup screen. When the red period is over
click on the Start button to go back to a green condition.

Note: Leave red even if running under yellow until ready to go back green then press Start button unless

scoring yellows then press Start button and press Caution-Score.

Lineup Screen

When the Caution, Caution-Score or Red Flag buttons are clicked a screen with the current lineup will
appear showing the order the cars crossed the start/finish line during the last complete lap or it will show the
last race position depending on whether or not the Use Race Results for Lineup checkbox on the Setup
page is checked.
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2.3.19
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5 3 -13.3687 5 3 -13.387

* Down
* B ottom

F_\‘) Feset

|Jpdate
Scoreboard

Jpdate Metwark,

Pririt

Fig 2.3.18-1

The left hand side of the screen shows the lineup according to the scoring system. The right hand side is
used to modify the scoreboard output. Adjustments can be made on the right hand side of the screen. To do
this you click on one of the entries on the right so that it is highlighted. Then, click on one of the buttons on
the right to either move the selected entry up or down.

The Top button moves the entry all the way to the first place position. The Bottom button moves the
participant to very bottom of the list. The Up and Down buttons move the entry up and down one position
respectively.

Once you are satisfied with the rearrangement the Update Scoreboard button may be clicked to send the
modified arrangement to the scoreboard. The Update Network button may be used to send the modified
update over the RMonitor feed. This is useful for updating devices with the lineup that use the RMonitor
feed.

Note 1: Modifications on the Lineup screen do not change the actual positions of the cars. The
modifications are for the benefit of the scoreboard display.

Note 2: While the Lineup screen is displayed the scoreboard will not update positional changes in non-
scoring cautions conditions.

Finish Button

Click the Finish button right before the leader takes the checkered. This allows each competitor to be
scored for only one more crossing. All subsequent crossings are recorded but not scored. This prevents the
leaders from being accidentally scored if they do not get off the track right after crossing the start/finish line.
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When the Finish button is pressed a line with checkered flags will appear on the crossing window. When a
crossing occurs after this line a small checkered flag will appear next to the racer on the Place/Qualify
window to indicate the racer has taken the checkered.

NOTE: This is a useful feature to determine if there are racers still left on a track.

=* Race Manager - C:'Westhold'ProductsRMS',Source’, TimePro'RaceMar_139049'Recovery.CSY
File ©ptions Export  Help

LElp: I 2 I~ Down [ Rbon - Practice Qualify View Ceorebanrd Elapsed Total Elapsed Green— ;
| omaras | 003624 =
| Session Name
Place Mo, Mame Trns... |L La Adjust
| | h2 2 | ] | Index |MNao. Marme |Trns bn] |Lap |Laptime |Speed
E 1 g5 Bob Two 14185 |2 00,000 o
B6-L 85 Bob Two 14185 e ==
E 2 449 Christine Three 14449 2 -00.070 1] = e P— e
ristine Three
Ernie Fo 14716 -00.119
E e 49 Fred Five 14649 |2 -04.697 "
&) 49 Fred Five 14649
E 5 67 Adam One 14067 |2 -04.699 o
10 &7 Adam One 14067
3 14462 0 -3 Laps il e
11-L |449 Christine Thr... 14449 1 08.461 0.000
12 85 EBiob Two 14185 1 05.674 0,000
L5} 16 Ernie Four 14716 1 05,393 0,000
14 49 Fred Five 14649 1 05,915 0,000
il 67 Adam One 14067 1 05,927 0,000
16 ID=14462 14462 == |lz=m b
18-L |85 Bob Two 14185 2 36:11... 0.000
19 449 Christine Three | 14449 2 36:11 0,000
20 16 Ernie Four 14716 2 36:11 0,000
21 49 Fred Five 14649 2 36:13 0,000
e 67 Adam One 14067 2 36:13.,. 0,000
o0 mhwe s e - —
20 ChnaThves 14449 o
25-0e ErieFow 14716 e e
|
<
All Single Flesultsl
Print——
PRE- CAUTION CAUTION - FEDFL&G || =2 2 LIELF |
TOP
‘\ STERT [F1) ‘\ START [F2) ‘\ i3 SCORE (F4) ‘\ FE || FMISHEEL ST e

Fig. 2.3.19-1

NOTE: If not able to click Finish button before leader crosses start/finish then make sure to press Stop
button before leader gets back to start/finish again.

If the Finish button were accidentally pressed the race can be continued by clicking on the Start button.
The finish flag line will disappear and the deleted crossings will be turned into green flag crossings.

2.3.20 Stop Button

Click the Stop button to stop all scoring. When this is done a window will pop-up and the user is given a
chance to save the results of the timing session. The default file name is the name of the assignment
template used. You can change this by typing the name of the file to save the data as and click OK. If
Cancel is clicked, no data is saved. However, it is still possible to save the data by going to the menu item
<FILE>\<SAVE RESULTS>.

NOTE: A very useful feature is the auto save feature. When the Stop button is pressed Race Manager
automatically saves the race data in a folder called ‘AutoSave’. This folder is located in the directory that
Race Manager is located in.

Attention: For Windows Vista machines and higher this may not be the case. If your PC is configured for
multiple users (User Control ON - default for Vista PCs) you data will be stored in a virtual directory under
your main C drive. This is often called: C:\Users\AppData\Local\VirtualStore\Program Files\Perrano. The
auto saved races are named with the assignment name first followed by a date/time stamp.
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2.3.21 Crossing Window Pop-Up Menu (Used to modify crossing status)

A pop-up menu will appear by right-mouse clicking when the mouse pointer is over the Crossing window.
Various selections may be made to change selected crossings from pre-start to green to caution, to scoring
cautions and red conditions. There are also four other selections: Insert Manual Crossing and Delete
Crossing. These selections are used to insert a manual crossing or delete crossings (manual or electronic)
for the driver selected on the running order window on the left-hand side of the screen. The last two
selections: Insert Lap and Delete Lap. These selections are used to insert a full lap to or delete a full lap
from a single car or the entire field.

2.3.21.1 Changing Crossing Type

Individual or multiple crossings may be selected for and their crossing type changed by first highlighting the
desired crossing and then right-clicking the mouse with the mouse cursor in the Crossing window. Select
the desired choice such as Set Caution and the crossing type will change. This is a very useful feature used
to correct mistakes such as accidentally pressing the Caution button at the wrong time.

== Race Manager =[0jx
File Options Export Help

Lap: I 2 I™ Dewn [~ Fion-Practics  Quaify view |  Scareboard | “'apsad TU‘a'—‘ “'aﬂsed Green— RErEs] | El
| DEMO
PEe2 D | hiame | T D | Laps | L=g Indesx Mo, Mame | Tx ID | Lap | Laptime | Speed | Hits/Pa... &l
1 3 CThree 1002 2 00.000 5 . e prns =
2 4 DFour 1004 2 -00.019 5 5 C Three 100a =
3 S5 EFive 1005 2 -00.064 o . b Four 1004 =
4 6 |FSK 100e z ~00.084 11-L 4 D Four 1004 1 05022 0000 @ 255/00
2 B (=i | = At 12 5 E Five 1005 1 05594 0,000 255,0.0
b S L= S P TG 2 -00.151 13 & F Six 1006 1 |ossso .00 255/0.0
’ 9 |1Mine 1082 2 “h0zE2 14 7 G Seven 1007 1 (o559 o0 255/0.0
B 10 |ITen 1010 t “Llaps 15 & H Eight 1008 1 05578 | oom 255/0.0
9 01 A One 1001 1 -1Laps 16 _ ong mmm
10 2 B Twao 1002 1 -1Laps 17 10 Set Pre-start o 1 05,530 0,000 255/0.0
Set Green
18 o1 Set Caution 1 1 05591 0,000 2595/0.0
19 2 Set Caution - Score 2 1 05.594 0.000 255,0.0
Set Red Flag
20 3 Farce Count = 1 |0ssee 0.0 255/0.0
21-L 2 Insert Manual crossing P13 2 05022 0000 @ 255/00
22 4 Delete Crassing 4 2 05585 0.000 255/0.0
23 5 Tnsert Lap 5 2 05544  0.000 255/0.0
24 5 Deletelen 5 2 05524  0.000 255/0.0
25 7 G Seven 1007 2 05487 0.000 2595/0.0
26 g HEight 1008 2 05503 0.000 2595/0.0
27 3 I Hine 1009 2 05573 0000 255/0.0
=l
Bl | o J| Al |[Single | Resuts|
ﬂ\ PRE \ START “\ CAUTION EALIEH), ﬂ\ REDFLAG ani\ FINISH @ 570R M
Setup | Azzign  Timing I

Fig. 2.3.21.1-1 Crossing window right clicked
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== Race Manager =[0jx
File Options Export Help

Lap: I 2 I™ Dewn [~ Fion-Practics  Quaify view |  Scareboard | “'apsad TU‘a'—‘ “'aﬂsed Green— RErEs] | El
| DEMO
PEe2 D | hiame | T D | Laps | L=g Indesx Mo, Mame | Tx ID | Lap | Laptime | Speed | Hits/Pa... &l
1 3 CThree | 1003 2 00.000 . 0 Tron 01 Py
z 4 |DFowr | 1004 2 -00.019 = o o ore 1001 =
3 S |EFie 1005 2 -00.084 5 . N . =
4 & |Fsi 1008 2 -00.084 5 R C Thes 1o =
5 7 |GSeven | 1007 2 -00.125 " . O Four 1004 =
b S L= S P TG 2 -00.151 11-L 4 D Four 1004 1 05022 0000  255/0.0
’ 10 |1Ten 1010 ! “Llaps 12 5 EFire 1005 1 055 000 255/0.0
B oL |aore 1om ! “Llaps 13 5 F Six 1008 1 (05550 ooom 255/0.0
? 2 L o ! “1laps 14 7 G Seven 1007 1 (o559 o0 255/0.0
= c Highlighted crossing oo 15 & HEight 1008 1 05578 0.000 255/0.0
is changed \ 1677 I Nine 1009 255/0.0
17 10 1Ten 1010 1 0551 o0 255,0.0
18 o1 A One 1001 1 |0sss1 oaom 255,0.0
19 2 B Two 1002 1 0554 00 255/0.0
20 3 C Three 1003 1 |oS5s8 00 255/0.0
21-L 3 C Three 1003 2 05022 0000  255/00
22 4 D Four 1004 2 05585 0.000 255/0.0
23 5 EFive 1005 2z 05544 0000 255/0.0
24 & F Six 1006 2 05524 0000 255/0.0
=5 7 G Seven 1007 2 05487 0.000 255,0.0
2 8 H Eight 1008 2 05508 0.000 =500 |
Bl | o J| Al |[Single | Resuts|
ﬂ\ PRE ‘\ START “\ CAUTION EALIEH), ﬂ\ REDFLAG ani\ FINISH @ 570R M
Setup | Azzign  Timing I

Fig 2.3.21.1-2 Highlighted Crossing Changed

Note: Be careful using this feature. It is a powerful feature, but can have unintended consequences.

There is a special crossing type called Force Count. Depending on the selections made in the Setup page
sometimes a crossing may not be counted. For example after a returning to green from a caution the first
crossing is not counted if the Count First Crossing on Return to Green checkbox is not checked. If the
competitor has say gone to the pits and upon their return the crossing must be counted then select the Force
Count selection. See Fig 2.3.21.1-3 below.
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== Race Manager =10|x
File Options Export Help
LElpI IT [~ Down | RMan - Practice QualiyView | Scorcboard | "Elapsed Total—‘ "Elapsed Green— E:[:’sgl | ﬂl
| on:0s2a | oo:os2g
| TEST
PlEEe | | HETTE | T I | LEES | L2g Index V(= ‘ Marme | Tx ID |Lap Laptime | Speed | Hits/Pa... =l
5 oo (e e e Sty 7 61 E Five 9461 1 02,609 0.000 255/34.5
2 B k) e o g8 59 C Three 5839 1 02,599 0.000 255436.0
g L |[BIAEE Enicth 2 AR 9y &2 O Four 0462 1 255/32.5
4 50 | C Three 5850 1 -1 Laps 10-Ly 75 BB 6675 1 . . 54205
11-y 61 E Five: 9461 1 == === 255/31.5
12-v 59 C Three 5850 1 == === 2955/34.0
13 62 D Four 9462 1 - - 295/30.5
14 61 E Five 9461 1 - - 295/33.0
15 75 BB BE7S 1 - - 249/29.0
. . . 16-L 62 D Four 09462 2 04.315 0.000 255/31.0
Say t_hls Competltor “{ent nto 17 75 BE BE7S 2 04,161 0.000 2554335
the pits. Upon returning to the \ 18 61 E Five 3461 2 04257 0.000 255/95.5
track it is not counted since we = [ ——
just returned to green. S e
Set Caution
Set Caution - Scare
Set Red Flag
Insert Manual Crossing
Delete Crossing
Insert Lap
Delete Lap
=
Fig. 2.3.21.1-3 Force Count
== Race Manager =10|x
File Options Export Help
LElpI IT [~ Down | RMan - Practice QualiyView | Scorcboard | "Elapsed Total—‘ "Elapsed Green— E:[:’sgl | ﬂl
| on:06:33 | on:06:39
| TEST
PEE® D | harne | 1D | Laps | L=g Index V(= ‘ Mame |Tx 1D Lap | Laptime | Speed | Hits/Pa... =l
5 oo (e e e Sty 7 61 E Five 9461 1 02,609 0.000 255/34.5
2 B k) e o g8 59 C Three 5839 1 02,599 0.000 255436.0
g L |[BIAEE Enicth 2 AR 9y &2 O Four 0462 1 255/32.5
4 59 C Three 5859 2 -05.321 10-L-Y 75 BB 6675 1 . . 255295
11-y 61 E Five: 9461 1 == === 255/31.5
12-% o9 C Three 5839 1 - - 295/34.0
13 62 D Four 9462 1 - - 295/30.5
14 61 E Five 9461 1 - - 295/33.0
15 75 BB BE7S 1 - - 249/29.0
16-L 62 D Four 0462 2 04.315 0.000 255/31.0
17 75 BE BE7S 2 04,161 0.000 2554335
18 61 E Five 9461 2 04,257 0.000 255/35.5
. 19 59 C Three 5850 2 26,729 0.000 153/30.0

Fig 2.3.21.1-4 Crossing is now counted
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2.3.21.2 Insert Manual Crossing

There are two ways to add a manual crossing. The first way is done by selecting a car in the Place/Qualify
window on the left and selecting which crossing the manual lap should be inserted before on the Crossing
window.

== Race Manager i -(olx
File Options Export Help

Lap: I 2 I™ Dewn [~ Fion-Practics  Quaify view |  Scareboard | “'apsad TU‘a'—‘ “'aﬂsed Green— RErEs] | El
| DEMO
PEe2 D | hiame | T D | Laps | L=g Indesx Mo, |Name Tx ID | Lap | Laptime | Speed | Hits/Pa... &l
! S |[SaESr Ve 2 e 13 5 F Six 1006 1 05550 0000 255/0.0
B o |[lget U E SN 14 7 G Seven 1007 1 05591 0,000 2595/0.0
£ = |[HAr e E S 15 g HEight 1008 1 03578 0.000 2595/0.0
4 6 FSix 1006 2 -00.084 " . X - . =
5 7 | GSeven | 1007 2 -00.125 - 0 e Say we wa.nt to insert a 0 T
& 5 HEght 1008 z -00,191 o o \ crossing here ; =
’ 9 |1Mine 1082 2 “h0zE2 19 2 B Tyo 1002 1 |05534 00 255/0.0
B 10 |1Ten 1010 ! “Llaps 20 3 Three 1003 1 |oS5s8 00 255/0.0
? 01 |4o0re 100 ! “1laps 21-L 3 C Three 1003 2 05022 0000  255/00
1 2|k e £ ol 22 4 D Faur 1004 2 0558 0000 2595/0.0
23 E Five 1005 2 05544 0000 2595/0.0
22 oo = Pre'Star u 05.487  D.000 255400
Set Green ’ ’ ’
o6 ! HEi  Set Caution 05502 0.000 255/0.0
27 9 I Mir ::E ;:;“:l;g SEER 05573  |D0.000 255/0.0
Force Count
Insert Manual Crossing
Delete Crossing
Inserk Lap
Delete Lap
=l
Bl | o J| Al |[Single | Resuts|
ﬂ\ PRE ‘\ START “\ CAUTION EALIEH), ﬂ\ REDFLAG ani\ FINISH @ 570R M
Setup | Azzign  Timing I

Fig 2.3.21.2-1 Highlight Driver
A car will get a manual lap inserted before first car crosses. Note that the manual lap is created such that it

is exactly halfway in time between the crossing immediately before and immediately after the point it is
inserted. Manual laps are useful if a car misses the antenna loop by perhaps driving through the infield area.
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== Race Manager =10|x
File Options Export Help
LElpI IT [~ Down | RMan - Practice QualiyView | Scorcboard | ";Iapsed Total—‘ ";Iapsed Green— E:[:’sgl | ﬂl
| DEMO
PEE® D |Name 1D | Laps | L=g Index Ma, |Name Tx ID | Lap | Laptime | Speed | Hits/Pa... =
g £ (G = iy 13 & F Six 1006 1 05550 0.000 255,0.0
2 s |[BRets Ll 2 - 14 7 & Seven 1007 1 05501 0.000 255,0.0
3 5 |EFie 1005 . -00.054 15 & H Eight 1008 1 05578 | oom 255/0.0
4 pren i 2| 16 3 I Mine 1009 1 05582 |00 255/0.0
5 6 |FSsk 1008 2 “00.CB4 17 10 1Ten 1010 1 050 |00m 255/0.0
£ G|t | E ST 18 01 & One 1001 1 0sssl oooo 255/0.0
7 8 |HEght 1008 z -00.191 " ) T - ) v [ 255,00
g 9 [1nine 1009 z -00.282 - R - Manual crossing o e
° 01 |A0e |1001 ! laps 21L |3 C trree oo v 0000  255/0.0
10 2 |BTwo 100z t “Llaps 22 4 ogftur 1004 2 osses 0.0 255/0.0
23 5 Five 1005 2 05544 0000 255/0.0
24 10 1Ten 1010 2 tdaral rarual .
e & F Six 1006 2 05524 0000 255/0.0
28 7 G Seven 1007 2 |os487 D000 255/0.0
27 8 H Eight 1008 2 |osso3 om0 255/0.0
28 g I Mire 1009 2 |oss73 oo 255/0.0
=l
A | o || & [singe | Resuts]|
G . “\ START “\ CALTION SN “\ REDIFLAG ,;5\ FIMISH @ sT0R M

Setup | Aggign  Timing I

Figure 2.3.21.2-2 Inserted Manual Crossing

This first method requires that a transponder already have any entry on the left hand Place window. The
second method does not require this. To insert a crossing double click on the line on the Crossing window

that the manual crossing will be entered at. The Manual Racer Quick Add window will pop up.

 Manual Racer Quick Add x|
Index Mo, Tame Trns ID
1 1 Qe &y 1001
2 2 Two B 100z
3 3 Three C 1003
4 4 Four O 1004
5 5 Five E 1005
& =] Siz F 1006
7 7 Seven 1007
g g Eight H 1005
El El Mire I 1009
i
11 11 Eleven k. 1011
1z 1z Twelve L 11z
Ok, I Caticel |

Figure 2.3.21.2-3 Manual Quick Add Window
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Now either select the racer to add a crossing for and click the OK button or double click on the racer. This
will add a new manual crossing.

2.3.21.3 Delete Crossing

A crossing may be deleted by highlighting a crossing, right mouse click over the Crossing window and
selecting Delete Crossing from the pop-up menu. Manual crossings will be permanently deleted.
Electronic crossings will be grayed out and not counted towards scoring.

9 4 E Five Q054 z 14,796 o
0 3 D Four 083 Z 13,344 0
11-L 2 C Three 9082 3 11.738 0.
1z Jula] A One Q030 3 19,773 0.
13-Del BT EE
14 3 D Four 083 3 11.455 o
15 4 E Five 0G4 3 17.571 0.1
o Electronic crossing .|‘|
&l | Single ] Results] deleted — still saved,
S o but not counted.
BRT ‘\ CAUTION e ‘\ RED FLAG| & FINISH @ 5T

| | PLACE I ALL |

Fig 2.3.21.3-1
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2.3.21.4 Insert Lap

To add a lap to the entire field highlight the line where the lap should be inserted, right mouse click over the
Crossing window and selecting Insert Lap from the pop-up menu.

=lolx

| Elapsed Total Elapzed Green Eefresh | Sl
=2 ’7| _‘ ’7| —‘ [ etwork Lack
Index MO Marme | Ty 1D ‘ Lap | Laptirme ‘ Speed | Hits/Po... [
13 f F Six 1006 1 05.550 0.000 255/0.0
14 7 G Seven 1007 1 05,591 0.000 255/0.0
15 a H Eight 1008 1 05,578 0.000 255/0.0
16 9 I Mine 1009 1 05.582 0.000 255/0.0
17 10 1Ten 1010 1 05,5320 0.000 255/0.0
18 01 & One 1001 1 05,591 0.000 255/0.0
19 2 B Two 1002 1 05.594 0.000 255/0.0
20 3 C Three 1003 1 05,529 0.000 255/0.0
211 EN i R 2 05022 0000 @ 255/0.0
22 4 Sek Green 2 05.585 0.000 255/0.0
23 5 ek Caution 2 05.544  0.000 255/0.0
Set Caukion - Score
24 & Set Red Flag 2 05.524 0,000 255/0.0
25 7 Force Counk 2 05.487 0.000 255/0.0
o6 o Insert Manual Crossing o 05.503 0.000 255,0.0
Delete Crossing
27 Q 2 05,973 0.000 255/0.0
Delete Lap

Fig. 2.3.21.4-1
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=loi=

Elapsed Total Elapsed Green— Fefresh Srall
eboard | ’7| —‘ ’7| I etwork | Lock

Index Ma. Mame | T ID | Lap | Laptime | Speed | Hits/Pa... =l
13 i) F Six 1008 1 05.5350 0.000 255/0.0
14 ! 6 Sfmn ™ Note all crossings after the
15 8 H Eight wof .
" 5 N 10 inserted lap are bumped up
17 10 1Ten 10 by 1 lap
18 o1 A One 1001 1 05.591 0.000 255/0.0
19 2 B Two 1002 1 05.594 0.000 255/0.0
20 3 C Three 1003 1 05.589 0.000 255/0.0
22-L 3 C Three 1003 3 05022 0.000 255/0.0
23 4 D Four 1004 3 05585 0000 255,00
249 & E Five 1005 3 05.544 0.000 255/0.0
23 =) F Six 1008 3 05.524 0.000 255/0.0
26 7 G Seven 1007 3 05.487 0.000 255/0.0
27 g8 H Eight 1008 3 05.503 0.000 255/0.0
28 9 I Mine 1009 3 05.573 0.000 255,/0.0
[
Al | Singe | Resuls |
‘\ HED FLAE .-Q"ﬂ\ FIHIEH @ STORE M

Fig. 2.3.21.4-2

2.3.21.5 Delete Lap

A manually inserted lap may be deleted by highlighting the manual lap (ie Lap+1) and selecting Delete Lap
from the pop-up menu.

16 9 I Mine 1009

1 05,582 0.000 255/0.0
17 10 1Ten 1010 1 05,530 0,000 255/0.0
18 o1 & Cne 1001 1 05,591 0,000 255/0.0
19 2 B Two 1002 1 05,594 0,000 255,0.0
20 3 C Three 1003 1 05,589 0,000 255,0.0
|
2t eeewa— | -]
22-L 3 Set Green 3 05.022 0.000 255/0.0
23 4 et Caution 3 05585 0000 255/0.0
et Caution - Score
24 5 Set Red Flag 3 05.544 0.000 255/0.0
25 6 Foree Count 3 05,524 0,000 255/0.0
26 7 Insert Manual Crossing ] 05,467 0.000 255,0.0
Delete Crossing
27 8 3 05,503 0,000 255,0.0
Insert Lap
28 9 3 05,573 0.000 255,0.0

Fig. 2.3.21.5-1
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2.3.22 Results Tab

When the Stop Button is pressed and a timing session is concluded, the Results tab on the Crossing
window becomes enabled. Clicking on the tab shows the final results view of the session.

11-L 4 E Five 9084 3 13.488 66.726 21/32.0
12 1 E Two Q051 3 17.357 51.851 19/31.0
13 = C Three Q052 3 15.457 58,225 101/35.0
14 oo A Cne Q030 3 16,975 53.019 6E8135.0
15 &} D Four 9053 3 15.451 458,777 8/30.5
16-L 4 E Five 9084 4 28.707 31.351 2/29.0
17 2 CThree 9082 4 Manual Manual -
15 1 B Twa Q051 4 26,205 31,909 13/32.0
=
All I Single I Hesultsl
Results tab HELIR Print
iy START EUTION Cr L REDFLAGINGE  Fl
START SCORE enabled ALL
T T
Fig. 2.3.22-1 Results Tab
=* Race Manager - C:\,Westhold',Products'RMS"Source’, TimePro',RaceMgr_139049\Recovery.C5Y =121 x|

File

Cptions

Export Help

LElp: I g [T Down [~ Rkon - Practics Qualify Yiew Scaoreboard Sl e E:{{s;rk | Egé:i"l
| oosa50 | oosess
| Session Name
Fl Mo, ! Trns... L Adjust
i 2 | il | | Capzyieg | L | Flace |Mo. |Name |LaDs Misc |
1 g5 Bob Two 14185 |3 00,000 o
1 85 Bob Two 3 Expert
2 449 Christine Three 14449 |3 -00.001 o = S pr——— = PP
ristine Three ovice
14649 -0 9
= u = > _ 3 49 Fred Five 3 Expert
4 16 Ernie Four 14716 2 -1 Laps u] " -
= 7 P TaE7 2 B B & 16 Ernie Four 2 Movice —
5 5 &7 Adam One H Movice ? Top
t v
* Down|
* Battam
K‘) Feset
[~ St by Misc
Refresh
Metwark
_Al_] Single Resuits
Print——————
PRE- CAUTION CAUTION - REDFLAG | .2 LINELF |
START [F2 FINIEH [FE SRR
‘\STAHT[FH ‘\ F2) ‘\ 73] SCORE (F4) ‘\ o s (F6) @ 7 pLace | REsULTs |

Setup I Azsign  Timing I

Fig. 2.3.22-2 Results Screen

The results may be manipulated using the buttons on the right-hand side of the screen. Highlight the competitor to
modify and click on one of the buttons on the right hand side to move the competitor.

The Refresh Network button is used to send the modified results to applications that use the network broadcast or
RMonitor feed.



Note: After manipulating the results the data must be saved. Do this by selecting the menu item
<File>/<Save Results> or <File>/<Save Results As>.

If the Misc column were used in the assignment template you can sort the finish according to the Misc column
information. Note in the figure below that the finish order is sorted according to the Misc column as opposed to
showing the overall order.

BETF

—Elapsed Total—— [ Elapsed Green
| 00:5950 H| 00:58:56 §‘

Place |Mo. | Name [ Laps [ misc

1 449 Christine Three 3 Novice
2 16 Ernie Four 2 Movice
3 67 Adam One 2 Movice
4 as Bob Two 3 Expert
5 |4 Fred Five 3 Expert

2.3.23 Print Buttons

There are two print buttons. One button will print what is in the Place/Qualify window; the other button
will print all crossings found in the Crossing window. The functionality of the left print button will print
the appropriate information depending on whether the software is in qualifying or place mode as defined by
the Qualify/Place View button. Note that the button will change text to indicate what will be printed.
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Print
ﬂ Quaity | AL |

Frirt
Button changes text /
|7 Place I

depending on view >

mode selected \
Print

[ """ PLACE | RESULTS |

Fig 2.3.23-1

2.3.23.1 Print Dialog

When one of the print buttons is pressed a window will pop up. Depending on which print button is pressed
the window may look slightly different.

Print Notes Ei| R Print Notes x|

Enter Hatez and Prezz OK to Print oK I Enter Matez and Preszz OK to Print ok, I
| clicked an the Place print buttan | clicked on the All print button

Cancel | Cancel
IE:\Westhnld\Westhnld.bmp 2 IE:\Westhald‘\Westhold.hmp 5%,
[ Print Image [™ Print Image

[~ Lap Chart Farmat
OR

Fig. 2.3.23.1-1
2.3.23.2 Print Image

It is possible to include an image such as your organization’s logo or sponsor’s logo in your printout. Click
on the folder icon and choose the image you want to print. The only format Race Manager currently
supports is the bitmap format (.bmp files). If you have a JPEG (.jpg) or GIF (.gif) format image you can
open this in a program such as Microsoft Paint and then ‘save as’ a bitmap file.

In order to print the logo the Print Image box must be checked.

2.3.23.3 Lap Chart Format

Pressing the All print button will bring up a print window with a Lap Chart Format (See Fig. 2.3.23.1-1)
checkbox. If this box is checked a lap chart will print out instead of the usual All printout.
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2.3.24 Menu ltems

== Race Managet - C:\Westhold'ProductsRMS"Source’, TimeProRaceMgr_1390494Recovery.CSY

Fil= ©Options Export  Help

Open Results - : P

. [T Down [ RMon - Practice el s et Elapsed Tatal Elapsed Green

S . | oo5350 | oos5ase

Save Results As Session Name

Mame THns... La Adjust:
HEEERTER | | |Laps 2 | ) | Index Mo, Mame Trns ID
7 Bob Two 14185 |3 00,000 o
Exit 12 |85 Bob Two 14185
G Christine Three 14449 |3 -00.001 i} T = Eisgg IPETTS
rnie Faur
14649

3 -“ 14 49 Fred Five 14649

4 1 Etnie Four 14716 |2 -1 Laps 1]

g = P s s = 15 &7 Adam One 14067

lam One -1 Laps
: 1o e

17-L |85 Bob Two 14185
13 449 Christine Three 14449
19 16 Ernie Faur 14716
2n aa Frad Five 14640

2.3.24.1 File->Ope

Fig 2.3.24-1

n Results Menu Item

Select the File->Open Results menu item to open previously saved results and display them on the screen.
Open results may be adjusted using the Adjust Laps and the Set Green/Set Caution, etc features described
above on the crossing screen only. The results may then be re-saved.

2.3.24.2 File->Close Menu Item

This clears the data from the screen and from memory.

2.3.24.3 File->Save Results Menu Item

This will save the results on the screen.

2.3.24.4 File->Save Results As Menu ltem

This will save the currently open race results on the screen to a new file.

2.3.24.5 File->Exit

This will exit

Menu Iltem

the Race Manager program

2.3.24.6 File->Recover

This item allows for the recover of a race. If for instance your PC crashes or someone exist the Race
Manager program before the Stop button was pressed you can recover the race data. Normally when Race
Manager is restarted it will detect that the software was closed prematurely and will ask whether the user

wants to reco

ver the race.
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In some circumstances the user may have accidentally pressed the Stop button before the race finished. By
selecting the File->Recover menu item it is possible to recover the data.

NOTE: This will not work for IDU systems. On IDU systems once the Stop button is pressed the data in
the IDU will be deleted. However, some of the recovery data may still be on the PC hard drive and that data
may be recovered.

2.3.24.7 Options->Font Menu ltem

This option is used to change the font size of the place and crossings grids’ text. Note that the font is not
saved when closing the program.

== Race Manager - C:\ Westhold' Products',RMS' Source’, TimePro\RaceMgr Yer 137704 Release’ Results'

File | Options Export  Help

o _
Lap: I™ Down [~ RMon - Prastice Glualify Wiew | Scoreboard
Flace Mo, |Name |Tx jis) ‘ Laps | Adjust |
Index Mo
1 2 C Three aogz S [u]
1-L 2
2 on & Cne a0an t) u] 2 4
3 1 B Twao Q051 3 1]
3 oo
4 & D Four 083 ] [u] 7 ;
5 4+ E Five 0G4 ) [u]
5 S
B6-L 111}
7 1
g 2
9 4
10 S
11-L 2
= an

Fig 2.3.24.7-1
2.3.24.8 Export Menu ltem

The export menu allows the race data to be exported to HTML files or comma separated ASCII text files for
either uploading to a website or for further processing.

== Race Manager - C:4Westhold'Products’RMS', Source’, TimePro4RaceMgr_139049'Recover
File Options | Expart  Help

Flace {Electronic Results)
LE[p: I_ Sy ok Crossings - Single Gualify Wiew Scoreboard
RML Final Resulks
= Full Session Export
Place Mo, | Mame | Trns. .. | Laps | Lag | Adjust |
1 g5 Bob Two 141585 |5 00,000 1]
z2 4449 Christine Three 14449 |3 -00.001 1]
3 49 Fred Five 14649 |3 -0o.009 ]
4 16 Ernie Four 14716 |2 -1Laps ]
5 67 #dam Cne 14067 |2 -1Laps ]
& 14462 |0 -3 Laps 1]

Fig 2.3.24.8-1
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2.3.24.8.1 Export->HTML Menu ltems

Export->HTML->Place (Electronic Results) — Exports only the electronic place results.
Export->HTML->Crossings — Single — Exports only the crossings data for a single selected competitor.
Export->HTML->Final Results — Exports the modified results from the Results tab page.

Export->HTML->Full Session Export — Creates a final results page with links to all the single crossings
report for each competitor.

2.3.24.8.2 Export->CSV Menu ltems

The CSV exports operate just like the HTML exports except comma separated CSV files are generated.

2.3.24.8.3 Export->XML Menu ltem

The XML export operates like the HTML and CSV exports except there is only a single option.

2.3.24.9 Help Menu Item

This option is used to identify what version of software is being used and copyright information.

l:l Race Manager

File ©Options Export Mg

About

I_Elp: 2 !.—m———l I~ RMaon - Practice Qualify Wisw Seor
| DEMO

Place |Mo, | Mame | Tx ID | Laps | Lag | Adjust |

1 65 B Sixky s 2 00,000 1}

2 37 R Thirty too? 2 -00.016 ]

3 22 T T s 2 -00.067 1}

4 158 R Ten imnng 2 -Mnn.149 n

Fig 2.3.24.9-1
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3. Tutorials

3.1 Split Score Guide

This section describes how split scoring works. In this tutorial we will count caution is the leader plus one
or more competitors cross the start/finish before the caution is thrown.

1. Caution Handling Setup

Check the Finish Lap on Caution checkbox. This setting allows each driver to finish the current lap when
the caution drops. This only works with the Caution-Score button.

Check the Auto Delete Partial Laps for Caution checkbox. When the non-scoring Caution button is
pressed, partial laps are highlighted and deleted (crossings are still there, but not counted). If wanting to
count the lap check Count First Crossing on Return to Green when green flag is waved before the leader
crosses the start/finish line to count the lap. This is acting like the yellow was never deleted and it will count
the first crossing which will put the lap count where it would have been if had taken the lap. If you choose
not to take a partial lap and consider a lap not complete until the full field is pass the start/finish line then
DO NOT check Count First Crossing on Return to Green.

Attn: If you press the Caution button before the leader goes by, the auto delete function will not know that
the previous lap was a partial lap. It will end up auto deleting the previous lap even though it might be
complete. Software cannot know that this is the case.

=* Race Manager - C:'Westhold',Products'RMS',Source’, TimePro'RaceMgr_139049'Recovery.CSY
File ©ptions Export Help

— System Status/Control — Scoreboard Control

Receiver Type: ( |DU % IDEC Total Pasitions

Set Cornmn Port I‘I_ lﬂ
Versi0n1:_ IDaktronics vl ?;S;eboard

¥ Enable Scoreboard Output

Wersionz:

¥ TCRAP — Metwark. Broadcast Contral

Set TCPAP || 192.168.1.43:10001 IP Address: I 192.168.1.102
TePARFar [T eoo0
Sel Ml L i I 0 sec [~ Enable Server Set Parameters |

Set Min Power I 0dB ‘ r— Rk onitor

Set TCP/IP Port | I 50000
I Set Backup Trnz. Interval | I 1 sec [~ Enable Metwork
7 ; Set Cornm Port | I 1]

[ Enable Serial

s —

[~ Enable LapCeiver

™ Firish Lap on Caution (Dl for S core daps)
¥ Buto Delets Partial Laps for Caution N

apCeiver
I Use Race Results for Lineup
_ _ et Comnm Port
™ Update Scoreboard on Scored Caution

I Court First Crossing at Start

¥ Count First Crnssing on Retum to Greer Sound On

™ Score Fed Flag Laps

[ Auto Firish
[~ DEMOD MODE ON

Setup I Assigh I Tirnirg I

Fig 3.1-1
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2. If the yellow flag is thrown after at least the leader has crossed press the Caution-Score button. See fig
3.1-2

=[o] =|
File Help
Lap: 5 I™ Down Qualify Wiew |  Scoreboard ElEpset Ui scrol
- Laock
I 00004 33 ——
Place |Mo. |Mame [TxID |Laps |La
| | | = | = | In... |Ma. Marne |T>< i) |Lap |La|:utime |S|:ueeu:| ;|
1 99 Hal.., |7358% 5 0.000 1
11... |36A Jon... 7356 2 7.934 D.000
2 264 [Jon.., 7356 5 -0.002 1
12 o9 Hale.,. 7353 2 7925 0.000
3 93 Hanm... 7359 4 -1 Laps 1 -
13 12 Jim ... 7355 2 5.590 0.000
4 12 Jdm ... 7355 3 -2 Laps 1
14 o3 Ham... 7359 2 5.901 0.000
5 36E | Oliv..., 7332 3 -2 Laps | -
15 366 Olive,.. 7332 Z2 9,944 0.000
16... |99 Hale... 7358 3 T1.276 0.000
17 364 Jon.., 7356 3 7284 0.000
03 Han... 7359 3 7.510 0.000
19 9 Jirn ... 735G 3 7.535 0.000
20... |99 Hale... 7358 4 8.908 D.000
| J08 Jon... 7356 4 8.940 0.000
22 3 COliv,.. 7332 3 15.525 0.000
23 9 Han... 7359 4 12,343 0.000
At least Leader ha; Zo (99 Hale.. 7358 5  10.671 0.000
crosse [“:I 25 364 Jon... 7356 5 10,635 0.000
—— 701
7l | _>I_I
4| | | all | Single | Hesultsl
PRE- CAUTION - i LINEL
‘\ STAAT ‘\ START ‘\ CAUTION SCORE ‘\ RESTART .-\‘,:v\ FIMISH
Setupl Azzign  Timing |

Press this
button.

Fig. 3.1-2

The lineup screen will pop up showing the order. See fig 3.1-3 below. Note how cars 99 and 36A are first
and second and in the order they crossed before the caution. Now cars 36B, 93 are drawn from the previous
crossing. And car 12 comes in at the end.
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Criginal M odified
Pos M, Lag =| | Pos M, Lag =
1 Q9 0.0a0 1 Q9 0,000
2 2648 -0.002 2 2648 -0.002
3 366 -2 Laps 3 366 -2 Laps 5
T
4 a3 -1 Laps 4 a3 -1 Laps
5 12 -2 Laps 5 12 -2 Laps
T v
* Dramr
* Battarm
F_“) Reszet
|lpdate
- - Scoreboard
Fig 3.1-3
Now as the cars cross the start finish under caution...
20... |99 Hale.. 7358 4 8.908  0.000
21 364 Jon.., 7356 4 5,940 0,000
22 366 Qliv,,, 7332 3 15.525 0.000
23 |93 Han... 7389 4 12,343 0.000
24.. |99 Hale... 7358 5 10,671 0.000
25 364 Jon... 7356 5 10,633 0.000
26 |36B Oliv... 733z 4 16:29.... 0.000
27 12 Jirn .., 7355 4 17:112., 0,000
28... |99 Hale,,. 735& 5 - ---
23 |36B Cliv... 7332 4 - ‘\- Cars that already
ECE Han... 7352 g 17:41.... 0.000 crossed are not

|
4]

counted again.

Al | single | Feo ]

Fig 3.1-4

ol munuml b, CEUTION I ol HESTAHT' 2% FNisH

| LINEL

The lineup screen will still show what is in figure 3.1-3. To correct the lag values you can hit the “Reset”
button on the lineup screen. See fig 3.1-5. This is not necessary. The lineup will still be correct. The
number of laps displayed on the scoreboard should be lap 5 since that is the leader’s current lap.
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Criginal
Pos [, | Lag =1 | Pos Mo
1 99 0,000 1 k!
2 364 0,002 2 36
3 366 -1 Laps 3 36l
4 ] -17:36,9749 4 o3
5 12 -1 Laps 5 12
Fig 3.1-5

3. In the case where it is decided that the caution will not be scored and the leader has crossed before the
caution is thrown, hit the non-scoring Caution button. Fig 3.1-6.

I=TES|
File Help
Lap: 7 I Dowin Bualify Yiew | Scoreboard ElEpREd e = Scioll
Lock
I 00:31:43
Place |Mo. [Mame |TxID |Laps |La
| | | B | 2 | In... |Mo. |Name |TxID |Lap |Laptime |Speed ;I
1 99 Hal.. 7358 |7 0,000 1
24.. |99 Hale... 7358 5 10.671 0.000
2 364 Jon... T356 6 -1Laps 1 —
s 25 368 Jon... 7356 5| 10,633 0.000
3 366 Olv... 733 5 -7 Laps | -
26 36E Oliv,., | 7332 4 16:29,.,. 0,000
4 93 | Han... 7359 5 -Z Laps 1
27 1z Jim ... 7355 4 17:112.... 0,000
5 12 Jim... 73585 & -2 Laps 1
28.. |99 Hale... 7358 ] 17:0.453 0.000
29 36E Oliw... | 7332 Si 41.036 0.000
30 o3 Han... 7359 = 17:41.... 0.000
31 12 Jirnv .., | 7355 5| 09:15.... 0.000
32 364 Jom... 7356 6 26:28.... 0.000
33... |99 Hale... 7358 7 09:32.... 0.000

Press caution
button

| | _’I_I
| Al I Single | Results |
A RESTART

PRE- ‘\ START CAUTION CAUTION -

STAET SCORE
_Setup | Assign _Timing |

Fi

A FINISH

LIMEL

Fig 3.1-6 — Only leader has crossed

The partial lap will automatically be deleted. Fig 3.1-7.
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== Race Manager =lo]z
File Help

. [~ Down o Elapzed Time Seroll
Lap_ I [+ Qualify Yiew |  Scorsboard Lok
I 00:34:37 _—
Place |Mo. [Mame |TxID |Laps |La
| | | P | d | In... |Mo. Mame |T><ID |La|:| |Laptime |Speed ;l
1 99 Hal... |7358 6 0.000 1
24... |99 Hale... 7358 5 10,671 0.000
Z 364 |Jon.,. 7356 6 -09: 27624 1
25 364 Jon... 735G 5 10,633 0,000
3 366 Olv,.. |7332 5 -1 Laps 1 :
26 366 Oliv,.. 7332 4 16:29..., 0.000
4 93 Ham.. 7359 5 -1laps | :
7 12 Jim ... 7355 4 17012, 0,000
5 12 |Jim.. 7355 & -1 Laps 1
28... |99 Hale... 7358 b 17:0.453 0.000
29 3EE Oliv... |7332 5 41,036 0,000
30 a3 Han,.. 7359 5 17:41,.., 0,000
31 12 Jin ... 7355 5 09:15.... 0.000
32 368 Jan... V356 & 26i28,.., 0,000
|]|]|:> 3L 53 Hale... 7358 & -

Fig 3.1-7
All subsequent crossings will also not be scored.

Note that if you accidentally press the “Caution” button too late and more than 1 car has gone by that is ok.
The partial lap will still automatically be deleted. Fig 3.1-8

6 I™ Down Glualify iew Scoreboard Elapead) e Scol
Laock
I 00:37:13 e
3 |Mame [T=ID |Laps |La
| | | B | e | In... |Mo. Mame |T><ID |Lap |La|:utime |5peed ;l
Hal... 7358 & 0,000 1
24.. |99 Hale... 7358 5 10,671 0.000
A Jon... 7356 6 027624 1
25 3648 Jon... 7356 5 10,633 0,000
B oOlv.., 7332 & -1 Laps 1 -
26 |3EE Cliv.., |7332 4 16:29..., |0.000
Ham... |735% 5 -1 Laps 1 -
27 12 Jirn ... (7355 4 17:12,... 0,000
Jim.., 7355 5 -1 Laps 1
28... |99 Hale... 7358 b 17:0.453 0.000
20 | 3EE Cliv.., |7332 = 41,036 0,000
30 93 Han... 7359 5 17:41,... 0,000
31 12 Jim ... 7355 5 0%2:15.... 0,000
320|368 Jon... | 7356 & 26:28.... |0.000
33.. |99 Hale... 7358 &) --- ---
Say you pressed 4 |36E Cli 7z 5
; .. [IE - -
caution here. This is 0
OK
Fig 3.1-8

The lineup in this case is based on the previous lap completed (lap 6 — index 28). Fig 3.1-9 below.
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Criginal
Pos M. |Lag =| | Pos
1 k! 0.000 1
2 36E -1 Laps 2
3 93 -1 Laps 3
4 12 -1 Laps 4
5 364 -09:27 624 5
Fig 3.1-9

Note that anything can be changed by highlighting the crossings you want to change and right clicking the mouse
button on the crossings screen. Just select how you want to change the highlighted crossings. You can correct

mistakes you might have made. Fig 3.1-10.

2= Race Manager =lol =]
File Help
i : I— I~ Down o vi | Elapsed Time Serol
Lap i G Qualify Wiew Scoreboard Lok
I 00:42:48
Place |Mo. |Mame |TxID |Laps |La
| | | E | 2 | I | Mo, Mame |TxID |Lap |Laptime |Speed _‘|
1 99  Hal... 7358 6 0,000 1
24... |99 Hale... 7358 5 10,671 0.000
z 364 Jon... F356 6 -09:27.624 |
25 3640 Jan... 7356 =} 10,633 0.000
3 368 | Oliv.., 7332 5 -1 Laps 1 -
6 366 Cliv,.. 7332 + 16:29.... 0.000
4 93 |Ham... 7359 5 -1 Laps I :
27 1z Jim ... 7355 4 17:12,,,, 0,000
5 12 dim... 7355 5 -1 Laps 1
28... |99 Hale... 7358 b 17:0.453 0.000
29 366 Cliv,.. 7332 1 41,036 0.000
30 a3 Han... 7359 S 17:41,,,, 0,000
31 12 Jirn ... | 7355 5 o9ls.... 0.000
32 364 Jan... 7356 B 26028.... 0.000
33.. Hale... 7355 B == ==
&k WSet Pre-start - =
Set Green
Sek Caution
Set Caution - Score
Set Restart
Select what you want the

Insert Manual Crod
Delete Crossing | crossings changed. to.

1] | _’I—I
< | | Al I Single I Flesultsl

PRE- CAUTION - A LINEL
‘\ e ‘\ START ‘\munnu CLORE ‘\HESTAHT Adw  FINISH |:
Setup | Assign _Timing |

Fig 3.1-10
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